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Purpose 

This document includes important, late-breaking information about this release of Oracle Hyperion® 

Disclosure Management. Review this Readme thoroughly before installing Oracle Hyperion® Disclosure 

Management. 
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New Features 

For new features relating to installation, architecture, and deployment changes in this release, see 

“New Features” in the Oracle Hyperion Enterprise Performance Management System Installation 

Readme. 



Updated Disclosure Management Instance Viewer 

The Disclosure Management Instance Viewer is now fully compatible with SEC Viewer versions 2.2.x 

and higher. Previously, the newer versions would not show the reports with the XSLT transformation 

applied. Additionally, the Reports menu now shows the "long names" of the reports.  

Changing the Taxonomy Language 

The mapping tool can now show taxonomies in different languages based on the languages available 

for the taxonomy. For example, the IFRS taxonomy can be viewed in English as well as Spanish. When 

another language is selected, all XBRL names related to the concept tree and its various views, 

dimension member tree, tuple instance tree, search, and detail reflect the selected language. 

Additionally, the mapping tool can now show the taxonomy concept's XBRL name. This feature is 

targeted at power users who prefer to work with the concept names rather than their localized labels. 

Registering Documents 

A prompt for the report name of the document name has been introduced when you initially select a 

document in Disclosure Management. When the report name is set, Disclosure Management registers 

the document and stores the name in the Mapping Repository with the taxonomy mappings. You can 

administer mappings based on the report name in the Mapping Manager.  

Duplicating Reports 

Enhanced duplicate report options allow you to copy a document and its mapping to another physical 

document, specify the Disclosure Management report name (as seen in Mapping Manager), and view 

number formats associated with mapped items. Duplicating reports is an essential step in rolling 

forward a Disclosure Management document. 

Formatting Nonnumeric XBRL Mappings 

Formatting options have been introduced when working with "text block" XBRL mappings in which the 

data is based on concepts of the “xbrl.us:TextBlockItemType” type and its derivatives. Available 

formatting options are: rich text, plain text, and the default plain text format. 

Generating iXBRL 

A new generate iXBRL option has been added so that users can produce an iXBRL (in-line XBRL) 

document, and then open the document in the viewer. Documents generated in iXBRL enable users to 

view reports in human-readable .HTML format while maintaining the XBRL metadata embeded within 

the same document. In the UK, it will be compulsory for companies to submit their company tax return 

online in iXBRL format for accounts and computations.  

Document Properties 

Use the new Document Properties options to add and modify number prefixes and suffixes, as well as 

thousands and decimal separators for parsing numerical data within Microsoft Word or Excel 

documents when mapping. 

Specifying Default Formatting for String Data Types 

Administrators can now indicate the default formatting for specific string based data types by way of 

two new optional properties named "formatted" and "unformatted" in the mappingtool.properties file. 

The "formatted" property is useful to automatically apply a "rich text" format to specified data types. 

The "unformatted" property is useful to automatically apply a "plain text" format to specified data 

types.  

Each data type must be space separated and represented the following way: 

" ".  

The pattern for the properties is: 

[Space separated data types] 



=[Space separated data types] 

For example to indicate that concepts which are of the " " data type always use 

"rich text" formatting for " ", add the following entry: 

These properties are optional. If they are not provided, the "plain text" format is always used. 

 New Scaling By Factor Feature 

You can now scale numeric items when mapping. Scaling is a method whereby units of values are 

multiplied by a scale factor to determine the correct value to include in the instance document. Scaling 

eliminates the need to enter zeros when mapping numeric items. Scaling factors are defined as an 

exponent of 10. For example if the document has a mapped value of "2" and the scale factor is "3", 

then the value in the instance document is 2000. The default scaling factor is 0, which does not scale 

values. Negative scale factors of -1 and -2 are also supported. 

Date/Number recognition 

You can specify formatting options that instruct Disclosure Management how to transform a numeric 

value from a document format to a canonic XBRL, and additionally specify date recognition options. An 

XBRL instance document accepts only plain decimal number format (without the thousands separator 

and with decimals separator “.”), while an original Office document may use a different number 

formatting convention. When an iXBRL document has its fact values formatted in the same way as 

they are in original document, then format options are incorporated to target Inline XBRL document for 

use by subsequent iXBRL to XBRL transformations. You can also define a fact as a negative value 

instead of an absolute, positive value. 

Specifying the Name of the Schema in the Instance Document 

Administrators can now indicate which schema to reference within instance documents via a new 

optional property named "schemaRef" in the mappingtool.properties file. This property is useful when 

instance documents must refer to a schema URI rather than a local schema. The pattern for this 

property is: 

 

This property is optional. If it is not provided, the value from the corresponding 

" " property is used. 

Packaging Taxonomy Files in the Instance Documents 

Administrators can now indicate if instance documents should be packaged with their corresponding 

taxonomy via a new optional property named "package" in the mappingtool.properties file. This 

property is useful if the instance document does not have to be packaged with its corresponding 

taxonomy. . The pattern for this property is: 

taxonomy_#. package_#=true|false 

This property is optional. If it is not provided, 'true' is used as the default value. 
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Installation Information 

Late-breaking information about installation of EPM System products is provided in the Oracle Hyperion 

Enterprise Performance Management System Installation Readme. Review this information thoroughly 

before installing EPM System products. 
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Supported Platforms 

Information about system requirements and supported platforms for EPM System products is available 

in a spreadsheet format in the Oracle Hyperion Enterprise Performance Management System 

Certification Matrix. This matrix is posted on the Oracle Fusion Middleware Supported System 

Configurations page on the Oracle Technology Network (OTN) and listed in the Oracle Business 

Intelligence product area: 

http://www.oracle.com/technology/software/products/ias/files/fusion_certification.html 
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Supported Languages  

Information about supported languages for EPM System products is available in a spreadsheet format 

on the Translation Support tab in the Oracle Hyperion Enterprise Performance Management System 

Certification Matrix. This matrix is posted on the Oracle Fusion Middleware Supported System 

Configurations page on OTN (listed in the Oracle Business Intelligence product area): 

http://www.oracle.com/technology/software/products/ias/files/fusion_certification.html  
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Supported Paths to this Release  

You can upgrade to EPM System Release 11.1.2.1 from the following releases: 

Release Upgrade Path From  To 

11.1.1.3.x 11.1.2.1 

9.3.3.x 

Note: If you are starting from Release 9.2.0.3+, 

9.3.0.x, 9.3.1.x (except for Essbase 9.3.1.4.1, 9.3.1.5, 

9.3.1.6, and 9.3.1.7), or 11.1.1.x, Oracle recommends 

that you upgrade to Release 11.1.1.3 as your interim 

release. If you are starting from an earlier release, 

Oracle recommends that you upgrade to the highest 

level release that directly supports upgrade from your 

starting release.  

 

Security Synchronization between Essbase and Shared 

Services was removed in Essbase Release 9.3, starting 

with Release 9.3.1.4.1. Essbase and Shared Services 

Release 11.1.1.3, however, still synchronize security 

information. For this reason, if you are using Essbase 

Release 9.3.1.4.1, 9.3.1.5, 9.3.1.6, or 9.3.1.7, you 

must first upgrade all products to Release 9.3.3, 

instead of Release 11.1.1.3. 

11.1.2.1 

 

9.2.1.x 11.1.2.1 

http://www.oracle.com/technology/software/products/ias/files/fusion_certification.html


Release Upgrade Path From  To 

A release earlier than Release 9.2.1.x If you are upgrading from a release earlier 

than 9.2.1.x, you must first upgrade to a 

supported release and then upgrade to 

release 11.1.2.1. For upgrade procedures 

for the earlier release, see the product 

installation guides for the interim release 

that you are upgrading to. 

An environment that includes multiple releases, which 

can include an environment with one instance of 

Shared Services or an environment with two instances 

of Shared Services 

See “Upgrading from an Environment with 

Multiple Releases” in the "Upgrading EPM 

System Products" chapter in the Oracle 

Hyperion Enterprise Performance 

Management System Installation and 

Configuration Guide. 

Note: If you are starting from Release 9.2.0.3+, 9.3.x, or 11.1.1.x, Oracle recommends that you 

upgrade to Release 11.1.1.3 as your interim release. If you are starting from an earlier release, Oracle 

recommends that you upgrade to the highest level release that directly supports upgrade from your 

starting release. 
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Defects Fixed in this Release 

Defect 

Number 

Description of Fix 

• 9215005  Disclosure Management parses mapped numeric data. 

• 9215040  Decimals and precision parameters are not applied to instance document data. 

• 9445879   Users are unable to remove tuple mapping in tree mode on the Review tab. 

• 9455236 When mapping a unit that does not have a unit type, the review type gives a fatal 

error. 

• 9844931 Registry permissions cause the Disclosure Management extension setup to fail. 

• 10098089  Modify the "instancecreator comments" in Taxonomy Designer. 

• 10087873  Parse date data type concepts correctly. 

• 10087683  Instance generation performance issues occur. 

• 10087663  Eliminate need to replace special characters manually. 

• 10087649  Ensure that only .HTML extended character sets exist, and are allowed by the SEC.  

• 10087635  Data that is mapped to text block data types is not being saved as escaped .HTML. 

• 10087607  Value override performance is affected when there is large number of mappings 

present. 

• 10087596  Precision and decimal performance is affected when there is large number of 

mappings present. 

• 10087588  Mapping tool performance is affected when there is large number of mappings 

present. 

• 10063328  Scaling mapped values should add the corresponding zeros to the instance 

document. 



Defect 

Number 

Description of Fix 

• 9215005  Disclosure Management parses mapped numeric data. 

• 10278426  After editing a unit, the 'divide by' field is automatically applied. Although it is not 

immediately visible in Disclosure Management, it is manifested in the instance 

document. 

• 10355169  Duplicate contexts with dimensions exist. 

 

Defects Fixed in Patch Set Update 11.1.2.0.502 (10419051) 

Defect 

Number 

Description of Fix 

• 10409599 Duplicated domain/member mappings are created in the XBRL Viewer. 

• 10409636 Duplicate contexts with dimensions are generated in the instance document. 

• 10409634 Missing domain/member mappings occur in the XBRL view. 

• 10409558 Instance generation/validation fails on a Spanish OS/MS Office. 

• 10409593 When performing a validation, opening the Review tab, and then exporting an 

instance document, the performance is slow. 

• 10419740 The wrong context update window appears and the wrong context is mapped after a 

column is sorted on the Context tab.  

 

Defects Fixed in Patch Set Update 11.1.2.0.501 (10407033) 

Defect 

Number 

Description of Fix 

• 10363816 Formatted text needs to use entity codes for extended ASCII characters. 

• 10363794 Avoid redundant <DIV> nodes within escaped HTML 

• 10363806 Duplicate context with dimensions occurs. 

• 10356012 Duplicate units are created when merging doclets into master documents. 

 

Defects Fixed in Patch Set Update 11.1.2.0.500 (10266005) 

Defect 

Number 

Description of Fix 

• 10254710 Validation and export features are slow when a master document is validated. 

• 10260037 Hyperion Disclosure Manager performance issues with validations and mappings. 

• 10262695 The instance validation and instance generation features are slow.  

• 10264865 Disclosure Management performance issues occurred with data source mappings. 

• 10264867 SEC validation errors occurred with Disclosure Management documents with detail 

tagging. 

https://bug.oraclecorp.com/pls/bug/webbug_print.show?c_rptno=10278426
https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=FR%2011.1.2.1%20Open&rptno=10363816&query_id=51300&rptno_count=4&pos=1
https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=FR%2011.1.2.1%20Open&rptno=10363794&query_id=51300&rptno_count=4&pos=2
https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=FR%2011.1.2.1%20Open&rptno=10363806&query_id=51300&rptno_count=4&pos=3
https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=FR%2011.1.2.1%20Open&rptno=10356012&query_id=51300&rptno_count=4&pos=4


Defect 

Number 

Description of Fix 

• 10283290 When mapping in a Financial Reporting report using insert function grid with 

Hyperion Financial Management data source, the mappings fail. 

• 10296925 Update Disclosure Management to support the latest versions of the SEC Viewer. 

• 10296968 Instance documents are rendered properly using the latest version of the SEC 

Viewer. 

• 10298600 Removal of non breaking space characters from mappings that are being persisted 

into the instance document. 

 

Defects Fixed in Release 11.1.2.0.04 (10134386) 

Defect 

Number 

Description of Fix 

• 10094130 Data that is mapped to text block data types is not being saved as escaped HTML 

within the instance document. 

• 10126456 Highlighting mapped content in Microsoft Word, Excel and Financial Reporting 

requires a double mouse click. 

• 10153592 After a long period of activity in Oracle® Hyperion Disclosure Management the 

threads may become unresponsive resulting in 100% CPU allocation on the server. 

• 10154327 The Oracle® Hyperion Disclosure Management mapping tool performance is slow 

when a user switches between tabs in the mapping tool.  

• 10154379 The Oracle® Hyperion Disclosure Management validation and instance generation 

performance is slow. 

• 10154395 Implement the scaling feature in Oracle® Hyperion Disclosure Management. 

 

Defects Fixed in Release 11.1.2.0.03 (10054860) 

Defect 

Number 

Description of Fix 

• 10054467 When creating an Oracle® Hyperion Disclosure Management instance document, the 

taxonomy relative path is displayed in the instance document.  

• 10058693 Loading the Oracle® Hyperion Disclosure Management extension in non-English 

Office 2003 fails. 

Defects Fixed in Release 11.1.2.0.02 (10004588) 

Defect 

Number 

Description of Fix 

• 10004771 In Oracle® Hyperion Disclosure Management, when you select the domain member,  

the "attach Mapping" button is not available. 

 

https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?rptno=10058693


Defects Fixed in Release 11.1.2.0.01 (9703883) 

Defect 

Number 

Description of Fix 

• 9620697 When adding/refreshing a doclet, a script error occurs. 

• 9620721 Merged cells are not supported for Microsoft Excel. 

• 9620808 Unable to cancel adding a Microsoft Excel doclet. 

• 9621139 Unable to change document mappings by way of the Mapping Manager. 

• 9622541 Performance improvements in the Report Manager. 

• 9622595 Improve error handling and stability of the Report Manager. 

• 9622744 After creating a master document, the Report Manager should be opened. 

• 9622818 Improve performance of the Disclosure Management Mapping Tool. 

• 9622892 Concurrent user data source mapping results in errors. 

• 9738347 Update version number in the UpdateList.xml to enable automatic extension updates 

after the Disclosure Management service fix is applied. 

• 9761785 Validation errors are displayed if Microsoft Word document data contains currency, 

decimal or thousand and other symbols from Microsoft Word based data. 

• 9762055 Unable to rollover a mapped XBRL document to a new time period. 

• 9800025 The changes to the Number Document Properties are not being saved. 

• 9803330 The Review tab does not display tuple mappings. 

• 9804162 In the Disclosure Management Mapping Tool, selecting the "validate" button may 

produce errors in some cases. 

• 9804333 Validating a taxonomy concept mapping without contexts or units produces a format 

error on the Review tab. 

• 9825133 The dimension member mappings do not display in the Disclosure Management 

Mapping Tool when reporting against Hyperion Financial Management or Hyperion 

Essbase version 9.3.1.x data sources. 

• 9829289 Unable to remove XBRL mappings in the Disclosure Management Mapping Tool when 

mappings are performed against Hyperion Financial Management or Hyperion 

Essbase version 9.3.1.x data sources. 

• 9832167 When creating a duplicate of a master document that contains a Microsoft Excel 

doclet, the Microsoft Excel doclet is empty in the duplicated master document. 
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Known Issues  

Defect 

Number 

Known Issues 

9438319 The Taxonomy Designer download link in the EPM Workspace is inconsistent in some 

cases. 

9445879 Users are unable to remove tuple mapping in tree mode on the Review tab.  

To remove the tuple mappings, switch to the Concept tab in the list mode view. 



Defect 

Number 

Known Issues 

9448265 User is unable to select concept when minimizing the browser.  

When performing an XBRL concept mapping with a Financial Reporting report in the 

EPM Workspace, if the Concept mapping area is collapsed, then a concept cannot be 

selected. 

10033379  Formatting options affect instance generation.  

This issue occurs because formatting for detail tagging (SEC detail tagging) requires 

Microsoft Office Open XML, which is not supported by the Microsoft Office 2003 

Standard Edition. 

10158859 The  installer is supported in English only. 

10278426 After editing a unit, the 'divide by' field is automatically applied. Although it is not 

immediately visible in Disclosure Management, it is manifested in the instance 

document. 

10312949 In the Taxonomy Designer, when you insert or drag an element to the Definition View, 

the pop-up window does not show all arc roles. This issue prevents the operation from 

adding the element to the View.  

For the workaround, see: Showing All Arc Roles in Definition View. 

10337852 An error occurs when the Taxonomy Designer is opened on a Win2003 64-BIT 

Japanese operating system.  

For the workaround, see: Opening the Taxonomy Designer on an Win2003 64-BIT 

Japanese Operating System (10337852). 

10624030 To support non-ASCII characters, use a UNICODE format (for example, \u00D2) in the 
 file. 

11071231 

 

Mapping by way of drag and drop is not supported under a Windows 2008 Server.  

As a workaround, Disclosure Management clients installed under Windows 2008 should 

use the map button in Disclosure Management to create mappings. 

11072611 

 

Disclosure Management release version 11.1.2.1.000 does not support clustering or 

high availability.  

11659971 A non-ASCII report names may not be supported, especially when a report is named 

with multi-byte characters. Supported names may also depend on server and client 

locale combinations. 

11678105 Dimension members do not show if a default dimension does not exist. 

The Disclosure Management Mapping Tool may not show dimension members from 

taxonomies that do not define default dimensions. While it is XBRL valid to define a 

taxonomy that does not use default dimensions, it is common practice (particularly for 

SEC extension taxonomies) to define default dimensions. 

As a workaround, if the taxonomy uses XBRL dimensions, ensure that default 

dimensions are defined. 

11685132 Detailed tagging and bulleted lists are not supported.  

This issue occurs because formatted block tagging does not support all formatting 

facilities provided by Microsoft Office. 

11705496 When the browser language is set to Italian or French, then taxonomy mappings 

cannot be added to a data cell in a Financial Reporting report in the EPM Workspace. 

11710663  Fail to view the XBRL report with a non-ASCII report name. 

https://bug.oraclecorp.com/pls/bug/webbug_print.show?c_rptno=11678105


Defect 

Number 

Known Issues 

11724188 Mappings are lost when the Smart View grid is changed. 

If there are document level mappings applied to Smart View grid cells, then editing the 

grid (for example deleting a row or column, or changing the grid layout) may result in 

lost mappings. 

As a rule you should not change a Smart View grid that has Disclosure Management 

mappings. However, if the grid must be changed, modify the grid before mapping 

XBRL concepts, contexts, and units.  

11822459 An instance document based on the 2011 US-GAAP taxonomy is not recognized as a 

US-GAAP report and does not show up in the SEC viewer.  

Support for the 2011 US-GAAP instances will be made available in the first patch set 

update after release 11.1.2.1.000. 

11855208 Old .XSLT file prevents SEC Viewer from rendering. 

If an older version of the SEC Instance Viewer was previously installed, Disclosure 

Management uses the old version of the "InstanceReport.xslt" file rather than  

the new one. This causes the SEC Viewer to render the instance without the  

use of the style sheet (which makes it look poorly formatted). 

As a workaround, delete all the files in the folder where the SEC Viewer files are 

temporarily stored.  
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Tips and Troubleshooting 

Increasing Timeout Periods 

Some operations such as XBRL/IXBRL generation, doclets operations, and report duplication, may take 

a long time to process, which may result in a timeout error message. To increase the timeout period, 

create the “WebServicesTimeout” string value in the Windows Registry under the key: 

“HKEY_CURRENT_USER\Software\Oracle\Disclosure Management”. Specify the value in seconds.  The 

default value is 180 seconds (3 minutes). 

Disclosure Management Extension in Smart View (9914674) 

Installation of the Disclosure Management Client is performed by the Smart View extensions automatic 

update feature. In the Smart View menu in Microsoft Excel, choose Options and then select 

Extensions. Next select Check for Updates to download and deploy the extension. 

Showing All Arc Roles in Definition View (10312949) 

To show all arc roles in the pop-up window of the Taxonomy Designer:  

1. In Taxonomy Designer, open the taxonomy and switch to the Definition view (View > Definition 

> show all arc roles). 

2. Open the extended link node where the dimension members will be added. 

3. From the Element list pane, find and select the dimension member that needs to be added. 

4. Drag and drop the member to the appropriate node. 

A pop-up window titled "Select an Arc Role" is displayed. 

5. Select General to Special. 

Note that this arc role is temporary. 

6. Select the newly added item from the tree view. 

7. Switch to the element panel (on the bottom right corner). 

https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=&rptno=10312949&query_id=689200&rptno_count=7&pos=1


8. Expand the Selected Parent Link property. 

9. Select the Role property. 

A drop-down arrow appears next to "Special to General". 

10. Click the drop-down arrow and select member-domain. 

11. Repeat as necessary for all the dimension members. 

Opening the Taxonomy Designer on an Win2003 64-BIT Japanese Operating System 

(10337852) 

If you encounter an error opening the Taxonomy Designer on a Win2003 64-BIT operating system, it is 

possible that the „UBMAutomator_options.xml‟ file is corrupt, or there are invalid entries there in the 

xml file.  

1. Verify that the XML file is valid, and the value: 5,53 (line number, column number) is in this XML. 

2. In the In  file, change:  

   to: 

Retaining Changes to the xbrlData.properties File (11705045) 

When an upgrade to Disclosure Management is made, the  file is overridden 

with a newer version. Additionally, a backup copy of the previous version is created automatically with 

a  extension in the same directory as the new version. However, any custom settings from the 

previous version file are not merged or retained by the new version. If you have customized the 

previous version (such as the changing the proxy settings), you must reapply the changes to the new 

version manually.  
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Documentation Updates 

Accessing EPM System Product Documentation  

The most recent version of each EPM System product guide is available for download from the 

Enterprise Performance Management System Documentation area of the OTN Web site 

(http://www.oracle.com/technology/documentation/epm.html). For faster access to the 

documentation, you can also use the Enterprise Performance Management Documentation Portal 

(http://www.oracle.com/us/solutions/ent-performance-bi/technical-information-147174.html), which 

also links to EPM Supported Platform Matrices, My Oracle Support, and other information resources. 

Deployment-related documentation is also available from the Oracle E-Delivery Web site 

(http://edelivery.oracle.com/EPD/WelcomePage/get_form).  

Individual product guides are available for download on the Oracle Technology Network Web site only. 

Copying and Pasting Code Snippets from PDFs 

When you cut and paste code snippets from a PDF file, some characters can be lost during the paste 

operation, making the code snippet invalid.  

Workaround: Cut and paste from the HTML version of the document. 

https://bug.oraclecorp.com/pls/bug/webbug_edit.edit_info_top?report_title=DM%2011.1.2.1%20Completed&rptno=10337852&query_id=839000&rptno_count=5&pos=4
http://www.oracle.com/technology/documentation/epm.html
http://www.oracle.com/us/solutions/ent-performance-bi/technical-information-147174.html
http://edelivery.oracle.com/EPD/WelcomePage/get_form
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